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If you encounter any problems or have any question, please email slvpadmin@ucl.ac.uk. 

 

These instructions are based on someone using a desktop or laptop computer, which will give you a 

better experience with the website. The website does work on tablets or phones, though the 

screens, menus and options may look a bit different to the images in this guide. 
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YOUR ORGANISATION PAGE 

You can find your project page by visiting https://studentsunionucl.org/volunteering/organisations 

and searching for your project. It’ll look something like this: 

 

 
 

https://studentsunionucl.org/volunteering/organisations


 

Note that you’ll need to login (top right hand corner) using your UCL credentials. 

 

For the purposes of the website, we call projects ‘organisations’!  

 

Your organisation page has three main functions: 

• Advertising and managing your volunteering opportunities 

• Managing your volunteers – for example, seeing who has had their references and DBS 

checks back, and seeing their contact details. 

• Submitting and viewing your project documents, for example your project plan, risk 

assessment, etc. 

NAVIGATING YOUR WAY AROUND THE PAGES … 

From your organisation page you can navigate to the other functions using left hand side panel. 

 

 
 

You can view any of your opportunities via the ‘Opportunities’ tab. 

 

You can get back to your Organisation page from an opportunity by clicking on the ‘Read more about 

this organisation’ button at the top of each opportunity. 

 



 

 
 

EDITING INFORMATION ABOUT YOUR PROJECT 

Whilst looking at your organisation page, click on the ‘Edit’ tab. Then scroll down and amend the 

fields as per instructions below.  

 

 
 

 

Logo – When we set your project up on the website, we’ll put a placeholder logo. However, it’s 

preferable for you to create your own logo. You can use free graphic design sites like Canva.  

 

Description – Try to keep the description short and snappy – aim for 100 words maximum, and 

ideally less than 50 words. This will show at the top of any volunteering opportunities. 

 

Address – this should usually be set to the Students’ Union’s address i.e. 25 Gordon Street, London, 

WC1H 0AY. If you think it’s necessary to change this, please speak to your supervisor. 

 

https://www.canva.com/en_gb/


 

Email – If you do not have a UCL project email address and would like to have one, please speak to 

your Project Supervisor – otherwise you will need to use your personal UCL email addresses. 

  

Website – for most projects, your website will be your organisation page on our webpages, so 

please leave this blank. If you have another website, please speak to your supervisor. 

 

Contacts – please put in details of the Project Leaders here. 

 

Images, display and theme – you can add a banner image here (which goes at the top of your 

project page) but it’s not a requirement - the important thing is that you’ve uploaded a logo. 

 

However, if you wish you can put another image here that will show at the top of your webpage and 

opportunities – for example an image of some people volunteering. Make sure you have permissions 

to use the photos. 

 

Revision Information -  make sure the ‘Create new revision’ box is ticked. 

 

 
 

Press Save 

 

 
 

You’ve now created a new draft for your organisation record. We will then check your amendments 

and publish (or get back in touch if we’ve any questions).  

 

Until then, you’ll have two versions of your organisation record – the original published version 

(under the ‘View’ tab) and the updated-but-not-yet-published version (under the ‘Latest version’ 

tab.)  

 

If you need to make any further edits, click on the ‘edit’ tab. 

 



 

 
 

Note that any page with the faint diagnonal stripes is an unpublished version. This applies to your 

organisation page and your opportunities. 

 

Your revisions will not appear on our website until we’ve reviewed and approved them. 

 

EDITING YOUR VOLUNTEER OPPORTUNITIES 

Your ‘Volunteer Opportunities’ are the roles within your project. If they’re published, they’ll show on 

the Opportunity Finder on our webpages. If you’re no longer recruiting, you’ll need to unpublish 

them – you’ll still be able to see them, but other people won’t. 

 

Click on the ‘Opportunities’ tab. 

 

You’ll see a list of your volunteering opportunities, along with their current status. 

 

Click on the Opportunity Title you’d like to edit and then the ‘edit’ link.  

 

https://studentsunionucl.org/volunteering/directory


 

 
 

Name – this is the name of the volunteering opportunity. This is displayed on the directory, so 

please make sure it’s an accurate description of the role, and don’t just put ‘Volunteer’! Think of 

what will be helpful when students are searching for keywords on our website..  

 

Change to: You can only select ‘draft’ – this indicates that you’re creating a new draft. 

 

Recruiting?  - please tick this (or untick it) to let us know whether or not you’re actually recruiting at 

the moment. You may have updated the role but not be recruiting at the moment – this box will let 

us know your intentions.  

 

Time commitment – use the drop down box to select what the time commitment is.  

 

• Regular - on a weekly or fortnightly basis for at least 3 months 

• Short Term - volunteering on a weekly or fortnightly basis for less than 3 months 

• One-Off - volunteering at a single event with no longer-term commitment 

• Flexible - volunteering more than once, but with flexibility about when 

• Short Task - small job that could be done within a day with no long term commitment and 

with flexibility about when. Not an event. 

If you select ‘one-off’ there will be some extra fields to fill out. See below for details.  

 

Description - give a brief summary of the volunteer role: what volunteers will be doing, who they’ll 

be working with, what difference they’ll be making. This will be seen by everyone looking at the 

directory and will help them decide whether to ask for more information – think of it as your pitch 

for new volunteers. Short and snappy works best - try to keep to less than 150 words. Avoid the ‘edit 

summary’ option. 

 

Duties – describe what the volunteers will be doing. Again, try to keep this as brief as possible, and 

use bullet points. 

 

How many volunteers needed? – you don’t have to give a precise figure, but this will give people a 

sense of how many positions are available. 

 

Commitment - more information - provide more in-depth information about what the amount of 

commitment is, and when the volunteering is taking place – for example:  



 

• “2 hours on Wednesday afternoons during term 2” 

• “We expect you to volunteer for at least 20 hours during the course of the year” 

• “A one-off event on 22nd October, 11am – 4pm”.  

 

This will show up on the directory, so think what sort of information prospective volunteers would 

want to know. 

 

Who will the volunteers be working with? Who will the volunteers be coming into contact with 

during their volunteering?  

 

Training – provide information on how you’ll train the volunteers, and how long it will take. Students 

tell us that they like to see some detail here, especially if they’re unsure if they’re right for the role.  

If your project involves working with children, you should state that all your volunteers will need to 
complete ‘Volunteering with Children’ training. Your partner organisation may be offering additional 
training for your volunteers – if so, make sure to include it here. 

What measures have you put in place to ensure volunteers’ safety during COVID-19? 
Although there is not any government restrictions, it is still important to think about covid-19 
especially when working with vulnerable groups. Some students may still be anxious about 
volunteering in-person, so they’ll want to know that you’ve thought about this. 

Categories - Select the types of volunteering your project covers (you can scroll down the list, or just 

start typing to see if a particular category is covered). If you change your mind, just click on the little 

cross next to the term.  

 

Skills Developed -  Select the skills that the volunteers on this role are likely to gain. Students will be 

able to search for opportunities by skill at http://studentsunionucl.org/volunteering/directory/skills  

 

 
 

UCL Departments – keep this blank; we’ll fill this in for you. 

 

Location – broadly describe where your volunteering will take place. This could be a specific address 

or a description of areas of London. This will help potential volunteers decide if it’s in the right 

location for them.   

 

Postcodes -  Please provide the postcodes where the volunteering takes place, otherwise they will 

not show on our directory map. Use exact postcodes e.g. WC1H 0AY rather than just WC1H. You can 

add multiple postcodes. 

 

http://studentsunionucl.org/volunteering/directory/skills


 

.  

 

Use the postcode of your community partners, if that’s where the volunteering will take place. Make 

sure you keep this information up to date – if you sign up a new community partner, make sure you 

update the postcodes on the relevant opportunities. 

 

If the exact location is hard to specify, put an indicative postcode in that will at least give volunteers 

an idea of what part of London they might be in. You can find this by googling the address of a 

nearby organisation like a council, museum or business. 

 

If you don’t know exactly where your project will be taking place, leave this section blank. As soon as 

you have the location confirmed, make sure you go back in and add the postcode 

 

If the volunteering is remote, put in UCL’s postcode - WC1E 6BT 

 

Posted Date – ignore this field. 

 

Application Deadline – If you’ve a deadline, input it here. Note that you’ll need to add a time as well 

- use the 24 hour clock and use colons rather than full stops.  

 

The opportunity will automatically unpublish once the deadline is passed. 

 

If you don’t have a deadline, leave this field blank! 

 

Application Criteria - What are the minimum qualities, skills or prior experience that you’re looking 

for in volunteers? Please be as clear as possible, and only include points that are absolutely 

necessary for completeing the duties you’ve outlined above. If you’ve a minimum age requirement, 

mention it here too. Students tell us that this information really helps them decide whether or not to 

apply. 

 

DBS type needed Do volunteers require a DBS check? If so, please indicate what type. If you’re 

unsure, you can leave this blank and our admin team will fill this in for you. 

 

Disabilities information – please give as much information about how the volunteer role may or 

may not be accessible to people with disabilities. We appreciate this is a very broad area, but the 

information you provide will help students with disabilities assess whether this is the right volunteer 

role for them. This is also a chance to think about how you could make your project more accessible. 

Discuss with your supervisor if you’re unsure. 

 

Contact – who should prospective volunteers approach if they have questions about the 

volunteering opportunities? Use either your UCL email or your project email, if you have one.  

 

Application process – how should students apply for this role? It’s really important you’re as clear as 

possible – this will show interested students how to take the next step to volunteering with you. 

Please include the specific weblink or email they must use, rather than just writing ‘look at our 

website’ or ‘email us’. If possible include likely timescales. Do not use Googleforms as these are not 

data protection-compliant. 

 



 

Accepts volunteers under 18? It’s our policy that Student-led Projects should not accept volunteers 

under 18. 

 

Images, display and theme We suggest you do not edit anything here. 

 

Related articles and other content  - leave this blank – we’ll add this. 

 

Additional comments – anything else to add? 

 

Revision information – ensure the ‘create new revision’ box is ticked (if you’re editing an old 

opportunity). If you like, you can add some comments about what changes you’ve made. 

 

 
 

Click on ‘SAVE’ 

 

You’ve now created a new draft for your opportunity. We will then check your amendments and 

publish (or get back in touch if we’ve any questions).  

 

Until then, you’ll have two versions of your opportunity record – the published version (under the 

‘View’ tab) and the updated-but-not-yet-published version (under the ‘Latest version’ tab.)  

 

If you need to make any further edits, click on the ‘edit’ tab. 

 

Your revisions will not appear on our website until we’ve reviewed and approved them. 

 

EDITING ONE-OFF VOLUNTEERING OPPORTUNITIES 

You’ll be asked to complete the following additional fields if your volunteer role is a one-off event. 

This will create an event on the Students’ Union’s events webpages. 

 



 

 
 

Event Dates – put in the dates of the event – this will generate an event on the Students’ Union UCL 

events calendar. You’ll need to put times in as well – use 24 hour clock. 

 

Venue  - where does the event take place? 

 

Meeting Point – where should volunteers meet for the event? 

 

Dress Code – Should volunteers dress in a particular way? E.g. scruffy clothes and sturdy footwear 

for conservation activities, smart clothes for certain fundraising events. If this is a one-off event, this 

will show in the 'equipment needed' section of the event page. 

 

Wheelchair accessible? – even if you’ve provided information on the disability access question, also 

answer this as it’s a required field for the events calendar on our webpages. 

 

 

 

CREATING NEW VOLUNTEER OPPORTUNITIES 

To create a new opportunity, go to your main organisation page, then click on ‘Create Opportunity’. 

 



 

 
 

 Once you have a blank volunteering opportunity form up, the process is exactly the same as editing.  

 

We’re awaiting the introduction of a cloning function where you can replicate an existing 

opportunity. This is useful if you have some similar opportunities, and don’t want to type out the 

same details each time. In the meantime, if you’d like us to make copies of your opportunities for 

you to then edit, email us at slvpadmin@ucl.ac.uk 

 

Your new opportunities will not appear on our website until we’ve reviewed and approved them. 

 

WE’RE NO LONGER RECRUITING! 

Find the opportunity and click on ‘Edit’ (as per editing), 

 

Make sure the ‘Recruiting’ option is set to ‘No’ 

 

 
 

It’s also helpful if you put a note in the additional comments that you’re not recruiting for the time 

being. 

 

Save changes as per editing. 

 

We’ll unpublish your opportunity. 

 

Alternatively, just email us at slvpadmin@ucl.ac.uk and we’ll unpublish for you. 

 

REACTIVATING A VOLUNTEERING OPPORTUNITY 

Find the opportunity (as per editing). 

 

mailto:slvpadmin@ucl.ac.uk


 

  
 

The list will show whether the opportunity is published, and whether there is a draft awaiting 

approval. 

 

Click on the title of the opportunity you’d like to edit, then select the ‘Edit’ tab. 

 

Make sure the ‘Recruiting’ option is set to ‘Yes’ 

 

Make any further amendments, then scroll to the bottom and press ‘Save’. 

 

In particular, make sure the application deadline has been updated. 

 

The Volunteering Service will then review your changes and either approve or get back to you. Until 

we’ve done that, the opportunity won’t reappear on our website. 

 

 

 

 

VOLUNTEER ENQUIRIES 

We’ll email you every couple of weeks with a list of students who have asked for more information 

about your volunteering opportunities. 

 

You can also see details of students who are interested by clicking on the ‘Expressions of Interest’ 

tab on your main organisation page (note you can’t see this by looking at the individual volunteering 

opportunities). 

 



 

 
 

You’ll see any students who’ve asked for more information about your project. 

 

You can click on the student’s email and send them an email to say hello and let them know how to 

get involved.  

 

Tip: have a saved template email including the relevant info that you can send out to interested 

students in bulk to save time 

 

If there are a number of students to contact, use the download CSV button. 

 

Note that the ‘email selected users’ function isn’t working yet. 

 

Note that the students might have also shown an interest in other opportunities on our directory 

too. Nonetheless, a quick email will increase the chances of them choosing to volunteer with you.– 

don’t leave it too late! 

 

If you have a lot of enquiries, you can export the list as a spreadsheet by clicking on the 

‘Volunteering expressions of interest’ button. Make sure you save this data securely and delete it as 

soon as you’ve used it - it has students’ personal data on it. See UCL’s guidance on data security. 

 
If there are any students you know are definitely not going to volunteer with you, you can remove 

them from the list by clicking ‘reject interest’ under the ‘operations’ column. This is optional though 

– each July we’ll clear the entire list. 

 

ADDING VOLUNTEERS TO YOUR PROJECT 

If a student has expressed an interest, and you’ve accepted them as a volunteer, you can easily 

move them to your volunteer list by going to the ‘Expressions of Interest’ view, finding the student, 

then select ‘Turn Into Placement’ 

 

https://www.ucl.ac.uk/isd/ioe/about-it-for-ioe/keeping-your-data-safe


 

 

If you want to add UCL students who aren’t on the ‘Expressions of Interest’ list, then email 

slvpadmin@ucl.ac.uk with their names and UCL email addresses – we’ll add them. Alternatively, you 

can add them yourself: 

 
Find the relevant volunteering opp  
 

Click on ‘add placement’ 
 

 
 

Put in the user ID – this should pick up their name or email address. 
 

 
 

Press Save 
 

Go back to the organisation and click on ‘Placements’ to check that it’s worked. 
 

mailto:slvpadmin@ucl.ac.uk


 

 

YOUR VOLUNTEERS 

You can see who is registered as a volunteer with your project by looking under the ‘Volunteer 

Placements’ tab. 

 

This includes information about which volunteers have DBS checks, have references returned, and 

have completed ‘Volunteering with Children’ training. 

 

 

 

Note that the ‘email selected users’ function isn’t working yet. 

 

ENDING VOLUNTEERS’ PLACEMENTS 

If a student’s volunteering has come to an end, go to ‘Volunteer Placements’ and click on ‘end 

placement’. Put in the last date the student volunteered, and press ‘submit’.  

 

If a student never volunteered at all, click on ‘never volunteered’ then ‘confirm deletion’. They will 

then disappear from all of your volunteer lists. 

 

It’s important you do this correctly – we need to record if a student has volunteered in case they ask 

for evidence in the future, for example for job applications. If you’re in any doubt, please speak to 

your supervisor. 

  



 

 

SUBMITTING FORMS 

You must also use your project page to submit your forms, and view those that have already been 

submitted. 

 

 
 

For: 

• SLP Risk Assessment 

• SLP Project Plan 

• SLP Monthly Report 

• SLP Evaluation and Handover 

 

Click on ‘+Add form’ – this should open a new tab on your browser. 

 

 
 

Upload your form.  

 

Press ‘Submit Form’ 

 
 



 

Your Project Supervisor will review the documents and either approve them or get back with further 

questions. 

 

For SLP Partner Organisation Details 

 

Click on ‘+Add form’ 

 

Complete one form for each different partner you have (for example, 3 forms for 3 partners) 

 

Input the ‘Organisation Name’ 

 

Input the details of your contact at that organisation (you can include more than one by using the 

‘Add another contact’ button. 

 

Upload the Partnership Agreement, as well as any Proof of agreement, such as an email from the 

partner. 

 

Press ‘Submit Form’ 

 
 

Your  Project Supervisor will review the documents and either approve them or get back with further 

questions. 

 

Remember to add the postcodes of your partners to the relevant volunteering opportunities. 

 

 

 

 

Last updated: Aug 2022 


